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Sibelius 7.5
Quick Start Guide på svenska

Tack för din/er beställning av Sibelius 7.5

Innan du börjar med installationen av programmet, läs igenom denna Quick 
Start Guide eller den som medföljer i kartongen (på engelska). Den innehåller 
viktig information om installation och registrering.

I förekommande fall; notera dina System ID och Activation ID och spara 
dessa som en värdehandling.

Har du supportfrågor?
Vid köp av Sibelius 7.5 har du tillgång till 12 månaders kostnadsfri 
svensk support. Supporten innefattar:

• Installationshjälp 
• Frågor kring ljudbanken 
• Inställningar för att koppla ditt MIDI Keyboard till Sibelius 7.5 
• Avregistrering av licens för byte till annan dator 
• Hjälp och tips för rätt konfiguration av din dator

All support går via vårt supportformulär som du  
hittar på www.sibelius.se under fliken Support.  
QR-koden till höger tar dig direkt till supportformuläret. När 
du skickat in ditt formulär kontaktar vi dig snarast möjligt.

För information om utbildningar kontakta oss på 031-96 93 93 
eller via vår hemsida: www.sibelius.se .

Copyright © 2014 Avid Technology Inc. för den engelska utgåvan.

Copyright © 2014 musikskolan.se Öckerö AB för den svenska utgåvan.

Artikelnummer för den engelska utgåvan: 9320-65191-00

ISBN för den svenska utgåvan: 978-91-85791-35-4



musikskolan.se 3

Innan du installerar
Välkommen till Sibelius 7.5 från Avid. Detta avsnitt är en översättning av häf-
tet Sibelius 7.5 Quick Start Guide som följer med leveransen av ditt pro-
gram. Här hittar du anvisningar för hur du installerar och registrerar ditt Si-
belius på Windows och Mac. För utförlig information om hur du kan använda 
Sibelius 7.5, se Reference Guide som medföljer programmet som en pdf (välj 
File > Help) eller som kan köpas i bokform som en separat produkt.

Detta följer med i leveransen
Innan du börjar installera ditt program, kontrollera innehållet i kartongen. 
Utöver häftet Sibelius 7.5 Quick Start Guide ska det finnas ett kartongfodral 
som innehåller fyra DVD-ROM, märkta med Program DVD and Sound Li-
brary Disc 1, Sound Library Disc 2, 3 och 4. Där ska också finnas ett kort 
med viktig information. Vilket kort som medföljer beror på vilken typ av pro-
gramvara du har köpt:

• Sibelius 7.5 innehåller ett vitt kort med rubriken Activating Sibelius. Där 
finns en etikett med dina System ID och Activation ID. Om du har köpt 
en sådan licens kan du genast påbörja installation, aktivering och registre-
ring av din nya Sibelius 7.5-licens. Spara dina System ID och Activation 
ID som en värdehandling.

• Sibelius 7.5 Skollicens (Sibelius 7.5 Academic) som köpts av lärare/institutio-
ner eller studenter innehåller ett grönt kort med rubriken Education Eligibi-
lity Verification. Se nedan för information om registrering.

• Sibelius 7.5 Competitive Crossgrade innehåller ett gult kort med rubriken Cross-
grade Eligibility Verification. Se nedan för information om registrering.

• Sibelius 7.5 Uppgradering innehåller ett blått kort med rubriken Upgrade Eli-
gibility Verification. Se nedan för information om registrering.

• Sibelius 7.5 Fleranvändare (Sibelius 7.5 Multi-user) och Sibelius 7.5 Fler-
användare uppgradering (både för fristående datorer och för nätverk) 
som köpts av en av institution innehåller inget kort. System ID och Acti-
vation ID meddelas separat av leverantören.
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Berättigande till skollicens
För att vara berättigad att köpa Sibelius 7.5 Skollicens, som är rabatterad i för-
hållande till Sibelius 7.5, måste du verifiera din status som lärare, institution 
eller student. Därefter erhåller du System ID och Activation ID som gör att du 
kan aktivera och registrera ditt program permanent.

På det gröna kort som medföljer kartongen hittar du en kod (eligibility verifi-
cation code). Denna kod ger dig tillgång till Identit-E (en partner till Avid) för 
att göra verifieringen via internet. Gör så här:

Börja med att se till att du kan styrka din anställning / dina studier. Avid ac-
cepterar följande alternativ:

• En unik, giltig e-postadress som associeras med en utbildningsenhet, t ex 
med ändelsen .edu (Övers. anm.: Endast ett fåtal i Sverige.)

• Ett intyg som styrker din anställning eller dina pågående studier, tillsam-
mans med en kopia på giltig fotolegitimation. Brevet ska vara skrivet på 
engelska och på institutionens officiella papper (eller stämplat) och vara 
underskrivet av rektor/lärare (gäller studenter) eller chef/administratör 
(gäller lärare och institutioner). Ange kontaktuppgifter till den som läm-
nar intyget.

• Därefter går du ut på portalen för verifiering: www.identit-e.com/avid. 
Följ de olika stegen på webbsidan du kommer till. Du kommer att bli 
ombedd att skriva in din kod (eligibility verification code) som står på det 
gröna kortet som medföljer kartongen med Sibelius 7.5. Därefter får du 
möjlighet att skriva in din akademiska mailadress, ladda upp ett inskan-
nat intyg eller e-posta alternativt faxa ditt intyg.

Du bör få ditt serienummer inom två dagar. Under den här tiden kan du an-
vända den fullstora testversionen av Sibelius 7.5. Så fort du får ditt serienum-
mer kan du aktivera och registrera ditt program – se avsnittet Aktivera och 
registrera Sibelius 7.5 på sidan 8.

Om du har frågor angående verifieringsprocessen, gå till  
www.identit-e.com/avid och klicka på Contact us.

För mer information om berättigande till skollicenser, se  
www.avid.com/education.
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Berättigande till Competitive Crossgrade
För att vara berättigad att köpa en Sibelius 7.5 Competitive Crossgrade, som 
är rabatterad i förhållande till Sibelius 7.5, måste du verifiera din status ge-
nom en enkel on-lineprocess. Därefter kan du aktivera och registrera ditt Si-
belius 7.5.

På det gula kort som medföljer kartongen hittar du ditt serienummer och 
instruktionen att gå till www.sibelius.com/verify. Där fyller du i ett webb-
formulär med bilagor som intygar att du är berättigad till ett serienummer. 
Denna verifikation tar normalt 2-3 arbetsdagar och under denna tid kan du 
använda den fullstora testversionen av Sibelius 7.5. Via mail får du informa-
tion om att verifiering är gjord och då kan du aktivera och registrera ditt pro-
gram. Se avsnittet Aktivera och registrera Sibelius 7.5 på sidan 8.

Berättigande till uppgradering
När du köper en Sibelius 7.5 Uppgradering måste du verifiera din version 
innan du kan aktivera och registrera ditt program. På det blå kortet som följer 
med i kartongen hittar du en uppgraderingskod (upgrade redemption code) 
och instruktion att gå till account.avid.com/activation. Där ska du skriva 
in koden från det blå kortet och serienumret på den licens av Sibelius du vill 
uppgradera. (Detta nummer börjar med SC eller SW eller utgörs av ett Sys-
tem ID och ett Activation ID, beroende på tidigare version.) Du kommer då 
att få ett nytt Activation ID.

Om du stöter på problem under aktiveringsprocessen kan du fortsätta an-
vända den fullstora testversionen av Sibelius 7.5.

När du aktiverat din uppgradering kan du fortsätta med att registrera din 
uppgradering. Se Aktivera och registrera Sibelius 7.5 på sidan 8.

Problem?
Om du inte har rätt kort för verifiering (vitt, gult, grönt eller blått) i kar-
tongen, kontakta din återförsäljare av Sibelius. Om du stöter på problem 
med verifieringen av en skollicens (Academic), kontakta Identit-E ge-
nom att gå till www.identit-e.com/avid och klicka på Contact Us. För 
övriga problem med verifiering, kontakta Avid registration support via  
www.avid.com/support.
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Installera Sibelius 7.5

Systemkrav för Sibelius 7.5
Innan du installerar, kontrollera att din dator uppfyller följande systemkrav:

• Windows: Windows 7 SP1 eller senare (32- eller 64-bitar) eller Windows 8; 
Intel Core 2 Duo (eller motsvarande) eller snabbare; 1 GB RAM (4 GB och 
däröver rekommenderas); 750 MB hårddiskutrymme för enbart Sibelius 
(40 GB för Sibelius och Sibelius 7 Sounds), snabb hårddisk rekommen-
deras; DVD-läsare; ASIO-kompatibelt ljudkort rekommenderas. Skrivare, 
skanner, mikrofon och Midi-klaviatur behövs för några funktioner.

• Mac: Mac OS X 10.6.8 till Mac OS X 10.9; Intel Core 2 Duo eller snabbare; 1 
GB RAM (4 GB och däröver rekommenderas); 750 MB hårddiskutrymme 
för enbart Sibelius (40 GB för Sibelius och Sibelius 7 Sounds), snabb hård-
disk rekommenderas; DVD-läsare. Skrivare, skanner, mikrofon och Midi-
klaviatur behövs för några funktioner.

Administratörsrättigheter
För att kunna installera Sibelius måste du använda ett användarkonto med 
administratörsrättigheter på datorn. Om det är din egen dator och du är den 
enda person som använder den, har du förmodligen redan dessa rättigheter 
på ditt användarkonto. För att kunna registrera programmet efter installatio-
nen måste du antingen använda ett konto med administratörsrättigheter eller 
ha möjlighet att ange användarnamn och lösenord för ett administratörskonto 
när detta efterfrågas.

Vi rekommenderar att du startar Sibelius och registrerar programmet som 
administratör så snart installationen är slutförd. Om ni är flera personer som 
använder datorn rekommenderar vi att ni efter att ha aktiverat och registrerat 
programmet kör Sibelius med ett konto utan administratörsrättigheter. Detta 
för att öka säkerheten i systemet.
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Installera Sibelius
Sibelius levereras på fyra dvd-skivor. För att installera själva programmet, 
sätt in skivan som är märkt Program DVD and Sound Library Disc 1. I Win-
dows visas en meny med några olika alternativ. I Mac visas ett fönster med 
några olika installationsikoner. För att installera Sibelius, klicka (dubbelklicka 
på Mac) på Install Sibelius 7.5 och följ sedan instruktionerna på skärmen.

Om du installerar en fleranvändarlicens för nätverk, skall du installera och 
aktivera Sibelius License Server innan du installerar Sibelius på någon av da-
torerna i nätverket. Se vidare i Sibelius Licence Server User Guide, som du 
hittar i mappen Network License Users Only på DVD-skivan med Sibelius 
programvara. 

Installera ljudbanken Sibelius 7 Sounds
Sibelius 7 Sound är en högkvalitativ ljudbank som kräver 40 GB hårddiskut-
rymme, så se till att det utrymmet finns i din dator innan du påbörjar instal-
lationen. Sibelius 7 Sounds är fördelad på samtliga fyra dvd:er, med början 
på Program DVD and Sound Library Disc 1, följt av Sound Library Disc 
2, 3 och 4. Det spelar ingen roll i vilken ordning du installerar skivorna, men 
säkerställ att du installerar allt innehåll från samtliga skivor, annars kommer 
du senare få problem när Sibelius försöker ladda upp ljud.

För att påbörja installationen, sätt in Program DVD and Sound Library Disc 
1 och klicka på Install Sibelius 7 Sounds genom att klicka (dubbelklicka på 
Mac) på menyn. När denna installation är klar, fortsätt med Sound Library 
Disc 2. I Windows löper denna installation automatiskt, i Mac visas ett föns-
ter där du dubbelklickar på Install Sibelius 7 Sounds för att fortsätta.

Följ instruktionerna på skärmen för att göra klart installationen. Vid den för-
sta installationen av ljudbanken får du frågan om var du vill lägga den, men 
därefter läggs resten av ljudbanken på samma ställe. När installationen är 
klar, fortsätt med Sound Library Disc 3 och 4.

OBS! Installationen kan ta flera timmar då filerna är mycket stora.
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Aktivera och registrera 
Sibelius 7.5

Installera andra applikationer
Skivan Program Disc innehåller även andra, mycket användbara, applikatio-
ner som du kan installera genom att klicka (dubbelklicka på Mac) på följande 
titlar:

•	 Install PhotoScore Lite: ett program som kan läsa inskannade tryckta 
noter och sedan låter dig redigera, transponera och skriva ut dem i Si-
belius. Installera detta om du inte också har köpt PhotoScore 7 Ultimate 
(som installeras från separata skivor).

•	 Install AudioScore Lite: ett program som transkriberar musik som du 
spelar eller sjunger in i datorn via mikrofon. I Sibelius kan du sedan redi-
gera, transponera och skriva ut musiken på samma sätt som om du hade 
matat in noterna direkt. Installera detta om du inte också har köpt Au-
dioScore 7 Ultimate (som installeras från separata skivor).

•	 Install Scorch: en plugin för webbläsaren. Med hjälp av Sibelius Scorch 
får du möjlighet att visa, spela upp, transponera och skriva ut Sibelius-
noter från Internet.

Aktivering av Sibelius
Aktivering innebär att ditt Sibeliusprogram autentiseras mot en aktiverings-
server. En singellicens kan aktiveras på två datorer för eget bruk, en fleran-
vändarlicens i det antal som gäller i varje enskilt fall. 

När du installerat Sibelius för första gången kan du köra programmet som 
test-version under 30 dagar. Under den tiden kan du arbeta i Sibelius även 
om det inte är aktiverat, men efter att de 30 dagarna gått kommer du inte att 
kunna spara. Varje gång du använder Sibelius kommer du att bli påmind om 
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hur många dagar det är kvar av testperioden och du ges möjlighet att aktivera 
programmet. Aktiveringen görs snabbt och enkelt via internet, antingen di-
rekt på den dator där Sibelius är installerat eller indirekt på en annan dator. 
För att genomföra aktiveringen behöver du ditt System ID (11 tecken långt) 
och Activation ID (som består av fyra grupper om fyra bokstäver och siffror). 
För att hitta dina ID, se avsnittet Innan du installerar på sidan 3.

Så här gör du:
Klicka på Activate-knappen i dialogrutan Try Sibelius som visas varje gång 
du startar programmet, eller gå till File > Help och klicka på knappen Ac-
tivate Sibelius 7.5. I båda fallen startas en särskild applikation  som kallas 
Avid Licence Control (ALC).

I den första vyn får du se en lista på dina installerade Avid-produkter, inklu-
derat Sibelius. Klicka på knappen Activate till höger för att fortsätta (eller 
klicka på Done nere i högra hörnet för att lämna ALC utan att aktivera). 

I nästa vy tillfrågas du om du vill aktivera med hjälp av internet-anslutningen 
på den här datorn eller en annan dator (om den dator där Sibelius är instal-
lerat inte har koppling till internet). Du rekommenderas att använda anslut-
ningen på den dator där Sibelius är installerat, så välj om möjligt det alternati-
vet (This computer’s internet connection) och klicka på Next. Ange sedan 
System ID och Activation ID och klicka på Activate. Du får då en bekräftelse 
på att Sibelius har aktiverats. Klicka på Done för att lämna Avid License Con-
trol och återgå till Sibelius. Därefter kommer du att bli uppmanad att regist-
rera din Sibelius-programvara, och det bör du göra så snart som möjligt: se 
avsnittet Fördelar med registrering nedan. Om du väljer att inte registrera 
nu kommer du att bli påmind senare. 

Om du väljer alternativet Another computer’s Internet connection och 
klickar Next, kommer du att få instruktioner om hur du skall erhålla en li-
cens-fil genom att använda en annan dator. Denna fil måste sedan föras över 
till den dator där Sibelius är installerat (med hjälp av ett usb-minne). För att 
registrera din Sibelius-programvara med hjälp av internet på en annan dator 
behöver du gå till www.sibelius.com/register. 
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Fördelar med registrering
Genom att registrera din Sibelius-licens knyter du den till en enskild person 
eller institution. Registreringen är frivillig, men rekommenderas eftersom du 
vid registreringen får en Avid Support Code (ASC) så att du får tillgång till 
Avids support. 

När du genomfört registreringen kommer du att få e-post med information 
om hur du kontaktar Avid-supporten, så var noga med att ange din korrekta 
e-postadress.

Obegränsad fri support finns tillgänglig under dygnets alla timmar i kun-
skapsbanken och användarforumet som du hitta på www.sibelius.com/sup-
port.

Aktivera en andra kopia
Så kallade singel-licenser kan installeras på två datorer för personligt bruk. 
Installera helt enkelt Sibelius på din andra dator och följ instruktionerna ovan 
för att aktivera programvaran.

Flytta Sibelius till en annan dator
Om du behöver flytta Sibelius för att du t ex köpt ny dator måste du avakti-
vera (deactivate) Sibelius på den aktuella datorn. Då märker Sibelius server 
att denna licens inte längre används och den blir fri att installera på en annan 
dator. Därefter installerar, aktiverar och registrerar på den nya datorn enligt 
beskrivningen ovan.

För att göra detta, välj File > Help i den dator där Sibelius ska avaktiveras: på 
högersidan under Product activated klickar du på Deactivate Sibelius 7.5. 
Då startar Avid License Control (ALC), och i listan på installerade produkter 
klickar du på Deactivate i anslutning till Sibelius. Följ vidare instruktioner 
på skärmen. Observera att datorn måste vara uppkopplad mot internet för att 
du skall kunna avaktivera Sibelius.

Nu kan du installera Sibelius på din nya dator. Följ instruktionerna ovan för 
att aktivera programmet.
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Problem?
Om du får problem när du registrerar eller aktiverar, fyll i webb-formuläret 
på www.sibelius.com/documents/contact_form.html. Inkludera ditt Sys-
tem ID och Activation ID och beskriv på engelska ditt problem och den exakta 
ordalydelsen i de felmeddelanden du får, så kontaktar Avids supportteam dig 
så fort som möjligt. 

Nästa steg
Grattis! Du har installerat, aktiverat och registrerat din nya programvara Sibe-
lius 7.5. Här är några förslag på vad du kan göra härnäst.

Titta på den guidade rundvandringen
Med Sibelius följer ett antal filmer som visar hur du kommer igång med pro-
grammet. Gör så här när du vill titta på dem: Starta Sibelius, när Quick Start-
fönstret dyker upp klickar du på Learn-knappen. Det finns tre filmer att välja 
mellan:

•	 Quick Tour: en kortfattad genomgång av grundläggande funktioner i Si-
belius.

•	 What’s New: särskilt användbart för personer som har uppgraderat från 
en tidigare version av Sibelius, här får du en genomgång av nya funktio-
ner i Sibelius.

•	 Sibelius for Switchers: om du har bytt till Sibelius från ett annat not-
skrivningsprogram hjälper denna film dig att komma in i Sibelius arbets-
sätt.

Följ handledningen
För att hjälpa dig att komma igång med Sibelius finns fem projektbaserade 
handledningar som tar totalt ungefär en dag att gå igenom. Dessa projekt 
guidar dig genom alla programmets huvudfunktioner och låter dig lära i din 
egen takt. Vi rekommenderar att du arbetar igenom åtminstone de första två 
projekten innan du påbörjar något betydelsefullt eget arbete.

Gå till Quick Start > Learn > Sibelius 7.5 Tutorials för att öppna handled-
ningarna.
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Mångfaldigandet av denna guide, helt eller delvis, är enligt lagen 
om upphovsrätt till litterära och konstnärliga verk förbjudet utan 
medgivande av copyrightinnehavaren. Förbudet gäller varje form 
av mångfaldigande genom tryckning, kopiering, ljudinspelning, 
överföring till elektroniska medier etc.

Avid, Sibelius och Scorch är registrerade varumärken, tillhörande Avid 
Technology, Inc. i USA, Storbritannien och andra länder. Alla andra 
varumärken tillhör sina respektive innehavare. Produktinnehåll, spe-
cifikationer och systemkrav kan ändras utan föregående notis. 

Synpunkter på Kom igång med Sibelius 7.5

Vi strävar efter att förbättra vår dokumentation. Om du har kom-
mentarer, rättelser eller förslag gällande den engelska utgåvan av 
Quick Start Guide, maila till docs@sibelius.com.

Synpunkter, rättelser och förslag till den svenska utgåvan mailar du 
till kontakt@musikskolan.se.

musikskolan.se / sibelius.se
Ekelunden 20
475 32 Öckerö
031 -96 32 00
www.musikskolan.se / www.sibelius.se 

Om Kom igång med Sibelius 7.5

Kom igång!
Här följer några sidor ur boken Lär dig Sibelius 7  
(ISBN: 978-91-85791-30-9), som är en grundbok i Sibelius 7 och 7.5. 
Den passar även dig som redan kan en del, eftersom den lär ut smarta 
arbetssätt. Bokens författare är Claes-Bertil Nilsson, erfaren kursledare 
och lärare i digital notskrivning.
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Om tangentbordet i Sibelius 7.5

A9  använda  tangentbordet  när  man  arbetar  i  Sibelius  gör  
det  enkelt  a9  ”skriva”  in  musiken.  En  kombination  av  två  
eller  flera  tangenter  är  vanligt  t.ex.  [Ctrl+Shift+E]  [⌘+⇧+E]

De vanligast förekommande genvägarna 

[Esc]  avmarkera  
[Delete]  backsteg  
[T]  taktartssignatur	 	 	   
[K]  tonartssignatur	 	 	   
[Q]  välj  klav	   
[I]  instrument		 	   
[M]  mixer	 	 	   
[R]  repetera  
[X]  vänd  (Flip)		 	   
[N]  aktivera  insä9ning  av  noter	  
[Shift+T]  [⇧+T]  transponera  
[Ctrl+K]  [⌘+K]  ackordsymboler  
[L]  bågar  och  linjer  
[S]  fraserings-‐‑  och  legatobåge  
[H]  crescendo  
[Shift+H]  diminuendo  
[Ctrl+A]  [⌘+A]  markera  allt  
[Ctrl+3]  [⌘+3]  triol  
[Ctrl+5]  [⌘+5]  kvintol  
[Shift+P]  växla  mellan  panorama-‐‑  och  sidläge  
[Ctrl+B]  [⌘+B]  lägg  till  takt  på  slutet  
[Ctrl+Shift+E]  [⌘+⇧+E]  Engraving  Rules  
[Ctrl+Shift+I]  [⌘+⇧+I]  Inspector  
[Alt+1-‐‑4]  [⌥+1-‐‑4]  Voice  1  -‐‑  4  
[Ctrl+Alt+N]  [⌥+⌘-‐‑N]  Timeline
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musikskolan.se
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För  a9  notera  e9  intervall    
ovanför  markerad  ton  väljer  du:

För  a9  notera  e9  intervall  
nedanför  markerad  ton  väljer  du:

Prim                  Ters                Kvint            Septim          Nona
              Sekund        Kvart                Sext                OktavIntervall

+  4

Fönster i Sibelius 7.5

MenyfliksområdePartiturflikar Byt  flikÖppna  ny  flikDialogöppnare Gruppnamn

Dokumentinformation Zoomningsgrad  /  Zoomverktyg

Panorama

musikskolan.se
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Det numeriska tangentbordet (Keypad)

För  a9  öppna  Keypad  behöver  du  markera  
‣ View ‣ Panels ‣ Keypad. !!
Keypad innehåller  sex  flikar  som  ger  dig  
tillgång  till  olika  layoutbanker  med  musikaliska  
symboler.  Klicka  med  musen  på  de  olika  flikarna  för  
a9  gå  igenom  de  olika  layoutbankerna.  Du  kan  också  
använda  [F7  -‐‑  F12].  Har  du  tillgång  till  e9  numeriskt  
tangentbord  (rekommenderas)  kan  du  använda  [+]  [-‐‑].

Vanliga  noter Mer  noter Balkning  och  tremolo

Artikulation Jazzartikulation Förtecken

Keypad  hjälper  dig  a9  välja  notvärden,  tillfälliga  förtecken,  artikulation,  
bindebågar  och  andra  markeringar  för  a9  skriva  in  och  redigera  noter.

Den  understa  delen  med  siffror  används  för  
a9  ange  vilken  stämma  (voice)  som  skrivs  
eller  redigeras  i.  
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Ditt första notblad (New Score)

I  Quick Start ‣ New Score  börja  
med  a9  välja  (klicka)  mallen  Blank.

Klicka  på  Change Instruments  
för  a9  välja  vilket  (eller  vilka)  
instrument  som  skall  visas  på  
di9  notblad.    !
Du  kan  senare  lägga  till  och  ta  
bort  instrument.

För  a9  skapa  e9  notsystem    
för  sångare  väljer  du  Voice  ur  
gruppen  Singers.    
 
Klicka  därefter  på  Add to Score 
för att lägga in notsystemet i ditt 
notblad. 	

 
Välj  OK  för  a9  gå  vidare.

musikskolan.se
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Välj  3/4-‐‑takt  i  rutan  för  taktartssignatur  
Time Signature Setup.  !!!
Använd  rullningslisten    
för  a9  gå  vidare  till  tonart  
Key Signature.  

Välj  d-‐‑moll  i  rutan  för  tonartssignatur  
Key Signature Setup.

Skriv  nu  in  sångens  titel  (Scarborough  
Fair)  och  kompositör  (Trad.)  i    
Score Information Setup.    !!!!
Klicka  på  knappen  Create    
för  a9  öppna  di9  första  notblad.  

musikskolan.se
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Sibelius  har  skapat  fem  tomma  takter.  

Sibelius  7.5  har  en  mängd  verktyg  för  a9  underlä9a  arbetet  med  notblad.    
För  a9  få  en  bä9re  översikt  av  noterna  vid  inmatningen  kan  du  stänga  av  fönstret  
för  Timeline  och  välja  panoramaläget.  !
För  a9  aktivera  panoramaläget,  välj  fliken  View ‣ Document View ‣ Panorama  
eller  klicka  på  Panorama  i  statusraden  längst  ner  till  höger.  Genvägen  för  a9  
växla  mellan  normalläget  och  panoramaläget  är  [Shift  +  P]  [⇧  +  P].
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Innan  du  går  vidare  bör  du  spara  di9  notblad  (dokument).    
Välj  fliken  ‣  File ‣ Save.  
Sibelius  föreslår  filnamnet  Scarborough  Fair  eftersom  du    
ange9  de9a  som  titel.  Bekräfta  med  Save.  
Genväg  [Ctrl+S]  [⌘+S].

I  vårt  övningsexempel  (se  sidan  18)  använder  du  musen    
för  a9  placera  in  melodin  till  Scarborough  Fair.    !
För  a9  göra  de9a  behöver  du  lägga  till  tre9on  nya  takter.    
Genväg  för  a9  lägga  till  en  ny  takt  är  [Ctrl+B]  [⌘+B].  
Takten  som  läggs  till  hamnar  sist.

Du  kan  också  välja ‣ Home ‣ Bars ‣ Add Multiple or Irregular Bars 
för  a9  lägga  till  e9  valfri9  antal  takter.  !!!!!!!
I  dialogrutan  Create Bars  under  Number of  bars 
skriver  du  in  det  antal  takter  du  vill  lägga  till  (13  stycken).  
Bekräfta  med  OK.  Du  lägger  in  de  nya  takterna  genom  a9  
klicka  på  valfri9  ställe  i  notsystemet.  
Nu  innehåller  notsystemet  totalt  18  takter.
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Lägg till noterna 

I  fönstret  Keypad  hämtar  du  dina  noter.  
Klicka  på  halvnoten  och  placera  ut  den  i    
den  första  takten.  !!!!
Klicka  på  nästa  not  (wärdedelsnoten)    
och  placera  den  till  höger  om  den  blå  
inmatningslinjen.    !!!!!
För  a9  notera  en  punkterad  not  väljer    
du  först  notvärdet,  därefter  punkten.    
Placera  därefter  in  den  punkterade  
wärdedelsnoten.  !!!!
Fortsä9  nu  a9  skriva  in  resten  av  melodistämman  
till  Scarborough  Fair  (se  sidan  18).

Om  du  behöver  komple9era  med  en  ny  takt  på  valfri  plats  i  
notsystemet  använder  du  Add Single Bar.    
Takten  placeras  framför  den  takt  du  markerar  (klickar  på).  !
Genväg  [Ctrl+Shift+B]  [⌘+⇧+B].  
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